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1. Introduction to general graphics issues

In these notes we describe the preferred file formats for submission of graphics to IOP journals and
offer some suggestions to help with their preparation. You are asked to create and supply graphics
using the file formats and procedures outlined below. Please note that print requires a higher quality
than web or on-screen use and some figures produced for use on the web may not reproduce well in
print.

2. A note on copyright
If you wish to illustrate your paper using material for which you do not own the copyright then you
must seek permission from the copyright holder. It is the author’s responsibility to obtain copyright
permissions and IOP’s production or editorial staff are unable to undertake this on your behalf. We
strongly advise you to obtain permission to use the material prior to submitting your paper to an IOP
journal. Providing copyright information at submission reduces the likelihood of delays to publication
at a later stage when you will be asked to obtain copyright permission.

For full details on copyright issues, please refer to IOP’s Guidelines for authors which can be
accessed online at authors.iop.org.

3. Preferred graphic file formats
You should export or save any graphics in any one of the following formats:

e EPS, PDF, WMF, TIFF, GIF, JPEG and BMP.

Authors using LaTeX need to have their figure files in EPS format, although the LaTeX picture
environment can be used to generate simple figures, its use is not recommended.

4. Naming your files

Please name all your files, both figures and text

use only characters from the set a to z, A to Z, 0 to 9 and underscore (_);
do not use spaces in file names;

include an extension to indicate the file type (e.g., .doc, .txt, .eps, etc);

do not use any accented characters; for example, a, &, @i, 0, ¥, etc because these can cause
difficulties when processing your files.

4.1. Naming your figure files

In addition to the above points, please give each figure file a name which indicates the number of the
figure it contains; for example, figurel.eps, figure2.tif, figure2a.gif etc. If the figure file contains a
figure with multiple parts, for example figure 2(a) to 2(e), give it a name such as figure2a_2e.jpg, and
so forth.

5. Supplying graphics with Microsoft Word files
The preparation of graphics for papers written using Microsoft Word depends on whether your
graphics/drawing application provides suitable file export facilities.

5.1. Applications with suitable ‘export’ or ‘save as’ facilities
Please do the following.
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e Save each figure as a graphics file and embed each one into your Word document. Please see
appendix C for instructions on how to do this.

¢ In addition to your Word document with the figures embedded, please supply copies of all the
separate graphics files. We ask for separate figure files in case we have problems with the
embedded graphics during conversion of your Word file to PDF (for the peer review process).

5.2. Applications without ‘export’ or ‘save as’ facilities

Where it is not possible to create a separate file for a particular graphic (the drawing/graphics
application does not provide suitable ‘export’ options; e.g., Microsoft Excel) copy/paste the graphic
into your Word document. Note that you may need to use the Edit > Paste Special... option to
correctly paste the graphic into your Word document.

6. Supplying graphics with LaTeX

For articles prepared in LaTeX please supply all graphics in EPS format. In addition, please include
your graphics files in the LaTeX code using one of the standard LaTeX figure-inclusion commands
(e.g., \includegraphics) available via packages such as graphics or graphicx. Simple figures can be
generated with the LaTeX picture environment but this is not recommended, generating individual
EPS files is much preferred.

e Appendix A contains more detailed guidelines on EPS files.

e Appendix B discusses preparation of graphics using Microsoft Excel.

¢ Note: Keith Reckdahl has written an excellent overview of using EPS files with LaTeX (with
numerous examples). Go to http://www.ctan.org and search for the file ‘epslatex.pdf’.

7. Supplying application files

By ‘application files’ we mean files saved in the binary format of the application used to create a
graphic; for example, file formats such as Origin’s ‘.opj’, CorelDraw’s ‘.cdr’, Excel’s ‘xlIs’ or
PowerPoint’s .ppt. Please do not supply your graphics as application files only, please use the ‘save as’
or ‘export’ of your software to create the graphic in one or more of the file formats listed in section 3.
However, there are some applications, notably Microsoft Excel, that allow creation of graphics but
don’t offer a wide range of file export options. LaTeX users are referred to appendix B which
discusses preparation of graphics using Microsoft Excel.

8. Scaling of line widths and text

You should note that during the production and typesetting processes your figures may need to be
reduced or increased in size to fit the design of the journal. Scaling of graphics will, of course, affect
any line widths and the size of text present in the figures. In some cases lines may become extremely
fine and text difficult to read. To achieve the best results you are advised to prepare your figures at
approximately the size they will be reproduced in the journal. Refer to recent printed or electronic
copies of the appropriate journal to determine the size at which figures are typically reproduced.

9. Lettering on figures

Aim to keep the lettering on figures to a minimum and include as much detail as possible in the figure
caption. The fonts available for figures may not match precisely those used for the text but please use
standard fonts (Times, Helvetica, Symbol, Courier) where possible and make the lettering match the
text as closely as possible. Use of fonts from the Computer Modern family is also acceptable. Do not
title a figure, the description of it goes in the figure caption. Similarly do not place boxes or borders
around figures if they are not part of the illustration. These would need to be removed prior to
publication as they take up unnecessary space and are distracting.

10. Multiple-part figures
Where a figure consists of several parts, it is often convenient to create each as a separate figure file
rather than as a single composite figure. This allows the exact size and positioning of the individual
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components to be chosen separately to match the space available on the page. However if the precise
positioning of the components relative to one another is important then a single composite figure can
be produced. If different parts of a figure are labelled please include the labelling (but not the figure
number) on the figure itself so it is easy to tell which part is which. Please use (a), (b), (c) etc to label
the different parts. If the parts are to sit on a grid then care must be taken to ensure the individual parts
are consistent, have the same dimensions and use the same fonts and line widths.

11. Some notes on raster (‘bitmap’) graphics

11.1. Black and white line art
e Line art consists entirely of lines that are 100% black on a white background.
e Use a resolution of 600 dpi when you scan or export the image.
¢ To minimize the file size make sure that you scan or export the file using two colours only—
from within your software this may be referred to as ‘line art’ or ‘bitmap’ mode.

11.2. Greyscale images
¢ Greyscale images (for instance, black and white photos) contain a range of greys covering the
spectrum from white to black.
e Use a resolution of between 150 and 300 dpi when you scan or export the image. Higher
resolutions will increase the file size, often with little or no gain in final output quality.

11.3. Colour figures
e Use a resolution of between 150 and 300 dpi when you scan or export the image. Higher
resolutions will increase the file size, often with little or no gain in final output quality.
e The more colours used in a bitmap file the greater the file size so try to minimize the number of
colours—a maximum of 256 colours should be sufficient.

12. Graphics file sizes

We often receive individual graphics files (usually TIFF, or EPS containing a bitmap) in excess of
50 MB in size. Such huge files, even when compressed, can present electronic transmission problems
for authors. Generally, such large files can be avoided by appropriate choice of image resolution and
number of colours present in the bitmap. See section 11 for guidelines on resolution and colour.

13. The use of colour in graphics

The use of colour in figures can significantly enhance the appearance of the figures for an article and
we are pleased to offer free publication of colour figures in our Electronic Journals. However, for most
journals the use of colour in the print version is charged for and, unless paid for, colour figures will be
converted to greyscale images for print and thus may lose detail or clarity. In particular, colours such
as yellow, light greens and light blues generally reproduce poorly and may become indistinguishable
on conversion to black and white print. Please remember that colour figures from the web may also be
printed by readers of your paper on a black and white printer.

Line diagrams that contain coloured lines to distinguish various data sets can be extremely
difficult to read and interpret when the colour information is lost. For example, consider the lines
shown in figure 1 (note that this section of the guidelines has to be read on-screen or printed on a
colour printer).
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Figure 1. The use of colour in charts.

Figure 1(a) is a chart containing multiple coloured lines, as it would appear in the online version of a
paper. Figure 1(b) shows how the same figure would look in a printed paper where the colours are lost.
You can see that in figure 1(b) a number of the lines have very similar shades of grey which make it
difficult for a reader to distinguish between them without the accompanying letters. Consequently,
where loss of colour in a particular graphic may reduce its legibility, use one or more of the following
techniques to assist readers of the print version (or, indeed, anyone who prints your paper on a black
and white printer):

¢ use line markers (e.g., circles, crosses etc), labels or numbers to distinguish different data sets or
lines;

e use a combination of different types of dashed lines;

o vary the thickness of the lines;

e avoid the use of unnecessary background tints.

Any efforts to improve the clarity of your figures and diagrams will always be appreciated by
readers of your paper.

14. Some notes on file formats
14.1. Encapsulated PostScript (EPS)
e Our preferred format—see appendix A for more detail.

14.2. TIFF (Tagged Image File Format)

e To minimize file sizes, when you save or export the image use one of the common TIFF
compression options (such as LZW, if available). If you are using Microsoft Word make sure it
is able to import your TIFF files.

14.3. GIF (Graphics Interchange Format)

o GIF files are limited to 256 colours.
e Uses LZW (‘loss-less’) compression to reduce file size.

14.4. JPEG (Joint Photographic Experts Group)

e The JPEG compression method discards image data and is referred to as ‘lossy’ compression.
When saving directly from an application it is better to choose a loss-less format such as TIFF.
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e Although a ‘higher quality’ compression setting in your software results in less data being
discarded, JPEG compression may degrade details in an image—particularly in images that
contain type or vector art.

e Do not repeatedly resave a JPEG file because the loss of image data occurs each time you
resave the image. Always save JPEG files from the original (non-JPEG) image, not from a
previously saved JPEG.

14.5. BMP (Windows Bitmap)
e A simple file format with few compression options. Use TIFF instead.

15. Resources
The following web sites provide free software tools which can be very useful when preparing the
graphics for your paper; for example, converting various bitmap formats to EPS for use with LaTeX.

15.1. ImageMagick
A comprehensive set of free tools for manipulating almost all known graphics formats.
http://www.imagemagick.org/

15.2. GhostScript

Free tool for viewing, manipulating and converting PostScript, EPS and PDF files. GhostScript can
also create PDF files from PostScript files.

http://www.cs.wisc.edu/~ghost/

15.3. jpeg2ps
A free utility for converting JPEG files to EPS. DOS executables and C source code available.
http://www.pdflib.com

Appendix A: Preparing Encapsulated PostScript files (EPS)
Many applications such as Adobe® Illustrator, Freehand and Corel Draw allow figures produced with
them to be saved directly as an EPS file. This should be done wherever possible.

A.1. Fonts in EPS files
Many Encapsulated PostScript (EPS) files contain text formatted using specific fonts and unless your
EPS files use one of the standard PostScript fonts (such as Times, Symbol, Helvetica or Courier) your
graphics may not be portable to other computers and thus may not reproduce correctly (characters or
symbols may be missing, converted to Courier font or otherwise incorrectly formatted on output).
To avoid font problems please create all your graphics using one of the standard fonts (Times,
Symbol, Helvetica or Courier). Naturally, this does depend on whether the software with which the
graphics are prepared allows you to determine the fonts it uses. If you cannot change or select the
fonts within the application used to produce your illustrations, please consider exporting the graphic in
a bitmap format such as a 300 dpi TIFF (if the software provides this option)—if you are using LaTeX
make sure to convert any bitmaps to EPS files (using utilities such as ImageMagick (see section 15)).

A.2. Font embedding in EPS files
If you have to use fonts other than Times, Symbol, Helvetica or Courier please try to embed the fonts
within any EPS files that you supply with your paper. Again, the ability to embed fonts in EPS files
depends on the features provided by the application used to create the graphics.

Here are some example screen images from applications that let you control font output in EPS
files.
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Figure Al. Adobe Illustrator 9’s EPS Export Options dialog
box lets you embed fonts in the EPS file.
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Figure A2. CorelDRAW 10’s EPS Export dialog box allows
you to convert text to curves or embed the font data.
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Figure A3. Origin 6’s EPS Options dialog box lets you control font embedding.

A.4. Smaller EPS files (‘Level 2’ PostScript)

If you need to convert bitmaps to EPS you may want to consider creating EPS files that use so-called
‘Level 2° PostScript because this has in-built data compression features which can greatly reduce the
size of the resulting EPS file. Note that this can, depending on the software used, create EPS files
containing binary data.

A.5. Techniques to avoid when preparing EPS files

One technique for preparing EPS files from applications that do not directly support EPS file export
(under Windows and Macintosh operating systems) is to generate an EPS file using the system
PostScript printer driver—a type of ‘print to file’. However, although this method of preparing EPS
file might work, it is generally nof recommended because the resulting EPS file may not be useable .
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Figure A4. Using the PostScript printer driver
on Windows to produce an EPS file. This
method is nof recommended.
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A.5.1. Printing to file and renaming

One very important point to note is that under certain operating systems simply printing a figure to a
PostScript file and renaming that file to have an .eps extension is unlikely to produce a useable EPS
file. The PostScript file may contain commands that are not permitted in EPS files, so please try and
avoid using this technique under Windows/Macintosh systems.

Appendix B: Preparing graphics using Microsoft Excel
Our preferred procedure for dealing with Excel-generated graphics depends on whether you are using
Word or LaTeX to prepare the text of your paper.

B.1. Using Word
Simply copy and past the chart or graph into your Word document.

B.2. Using LaTeX
The goal is to create an EPS file and import that into your LaTeX source using \includegraphics{...}
or other graphics-inclusion command.

B.2.1. To create a useable EPS file from Excel for use with LaTeX. Here we’ll use GhostScript (under
Windows) to generate an EPS file but a similar procedure works just as well with Adobe Acrobat (full
version, not Adobe Reader). Perform the following steps.

1) From Excel, print the chart or graphic to a PostScript file.

Assuming you have access to a PostScript printer driver set up to ‘print to file’, print your
Excel chart to a PostScript file from within Excel (Note: Microsoft Office applications often
default to giving print files a ‘.prn’ extension). Make sure that under the Page Setup options
you set the printed chart size to ‘Use full page’. This will reduce white space placed around
the graphic—which can later be scaled to the required size using a LaTeX graphics-inclusion
command such as \includegraphics [width=8cm] {graphic.eps}.

Page Setup @E|

Page ] Margins ] Header Footer
Printed chart size

{+ Use ful page

™ Scale to fit page

™ Custom o~
Options. ..

Printing quality
[ Draft quality
[ Printin black and white

Figure B1. When you print
the chart to a PostScript file,
select the ‘Use full page’

o ] oot | option to reduce the white
"= space around the chart.

2) Turn the PostScript file into PDF.

Open the PostScript file using the GSView program that accompanies GhostScript (see
section 11, ‘Resources’). Generate a PDF file from the PostScript file by doing File >
Convert and selecting the ‘pdfwrite’ device option. See figure B2.
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Click OK, and give the PDF file a name.
3) Export the PDF file to an EPS file.

Using GSView open the PDF file produced in step 2, select File = Convert and choose the
‘epswrite’ device option. See figure B3.
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Figure B3. Converting a
PDF file to an EPS file
using GSView.

Options:

Click OK, and give the EPS file a name.
Appendix C: Embedding graphics in a Microsoft Word document
C.1. How to embed graphics into a Word document

e Create a graphic in one of the formats Word is able to import (for example, TIFF, JPG, EPS
etc).

e From the Insert menu, select Picture = From File... (see figure C1).

e When the ‘Insert Picture’ dialog box is displayed, click on the Insert button on the bottom right
corner of the dialog box (see figure C2).

o Select the Insert option (see figure C2). This will make sure that the graphic is saved with
(embedded into) the Word document.
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Figure C1. Inserting a graphic into a Word document.
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Figure C2. Embedding a graphic into a Word document.





